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Introduction 

How It All Began 

In early 2003 Peter PHP1PH and myself Simon HB9DRV talked about 

developing a simple program to control the soon to be released ICOM IC-703. 

We had previously developed the FT-817 Commander, which proved to be very 

popular, the main lesson being learnt that future programs must not be tied to a 

single radio or a single manufacturer; rather they must be designed to support all 

current and future radios. 

Maybe it was the beer, maybe the desire to give something back to the radio 

amateur community, however on June 6
th
, 2003 the first line of code was written, 

Ham Radio Deluxe (HRD) was born. 

The inspiration for the design came from a variety of sources: Internet Explorer 

(especially the Favourites), my old Eddystone EA12 and a desire to prove that 

Peter and myself could develop something better than the current ónot quite so 

free and fantasticô products being peddled to radio amateurs. 

On December 23
rd
, 2005 the number of registered users stood at 20,006 ï quite 

an achievement in such a short time. 

---   ---   --- 

Very sadly Peter passed away on June 8
th
, 2005. His contribution to Ham Radio 

Deluxe will never be forgotten. 

 



This Guide 

Kevin Crockett, VK3CKC, wrote the original user guide. Now that HRD is a 

more mature product the time has come to write the document you are currently 

reading. 

Thank-you for reading this guide - and before you ask itôs written in British 

English, with plenty of my favourite colours despite Wordôs attempts to change 

the spelling J. 

If you are only going to read one more section then now go to Radio Display on 

page 23. 

Please report errors and omissions to simon@hb9drv.ch or in the HRD forums 

http://forums.ham-radio.ch/ . 

The Name 

The influence for the name comes from Eight Ball Deluxe, which was one of the 

finest Macintosh games of the 1990ôs. 

   

Sponsors 

To help keep HRD free for all Amateurs and SWLôs several companies have 

helped by sponsoring the HRD development. If I have missed your company 

please let me know. 

And a very big thank-you to everybody when has lent radios to Peter and myself 

so that we have been able to provide the current level of support. 

 

mailto:simon@hb9drv.ch
http://forums.ham-radio.ch/
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Requirements 

Computer 

You can run HRD on any Windows 98 or Windows NT/2K/XP computer. Please 

note: version 3.4 is the last release that will óintentionallyô run on Windows 98. 

There will never be a LINUX or Macintosh native version, HRD is known to run 

under Wine for LINUX and PC emulators for the Macintosh. 

 

I may be crazy undertaking a project like this in my spare time
1
; I am not ódeep 

stir-fry serve in a bun with extra chiliesô crazy
2
! 

 

The code is not open source; it cannot be ported to Linux and will never be 

released as some of the code is protected under copyright and if released will 

land the author with a nice big legal ófeeô. 

Supported Radios 

You donôt need a radio ï HRD comes with built-in Dem-o-matic radio support 

(FTDX-9000, K2, Orion, TS-480, TS-570 and TS-2000). 

HRD currently supports these órealô radios: 

¶ Elecraft: K2 

¶ FlexRadio: SDR-1000 

¶ ICOM: IC-7000, IC-703, IC-706, IC-706MkII, IC-706MkIIG, IC-

707, IC-718, IC-725, IC-726, IC-728, IC-729, IC-735, IC-736, IC-

737, IC-738, IC-7400, IC-746, IC-746Pro, IC-751A, IC-751A 

(Piexx), IC-756, IC-756Pro, IC-756ProII, IC-756ProIII, IC-761, 

IC-765, IC-775DSP, IC-7800, IC-781, IC-821H, IC-910H, IC-R10, 

IC-R20, IC-R7000, IC-R75, IC-R8500, IC-R9000, PCR-1000 

¶ Kenwood: R-5000, TS-140S, TS-2000, TS-440S, TS-450S, TS-

480, TS-50S, TS-570, TS-60S, TS-680S, TS-690S, TS-790, TS-

850, TS-870, TS-940S, TS-950, TS-B2000 

¶ Ten-Tec: Argonaut, Jupiter, Orion, RX-350 

¶ Yaesu: FT-100, FT-1000D, FT-1000MP MkV, FT-600, FT-817, 

FT-840, FT-847, FT-857, FT-890, FT-897, FT-900, FT-920, FT-

990, FTDX-9000. 

                                                           
1
 It was the voices in my head that made me do it 

2
 Medical opinion may differ here 



Interfacing 

You will need a cable to connect your radio to the computerôs serial (COM) port. 

If you donôt have a serial port all is not lost ï USB ė serial converters are 

widely available. Please note: not all USB ė serial converters work well enough 

for HRD. If in doubt ask for a recommendation in the HRD support forums. 

For more interfacing information refer to: 

¶ The HRD Interface guide, and 

¶ CATbox, a Modular Computer Interface by Bas Helman G4TIC. 

These files are downloadable from the HRD download center - http://hrd.ham-

radio.ch/downloads.html. 

Check out the cable solutions from: 

¶ G4ZLP http://g4zlp.ham-radio.ch/ and 

¶ West Mountain Radio http://www.westmountainradio.com/.  

Public Interfaces 

Other (non-HRD) programs are supported via a DDE interface (see DDE 

Support on page 61) and a serial port (see 3
rd
-Party Programs on page 149). 

Logbooks typically use these interfaces; for example contest-oriented logbooks.

http://hrd.ham-radio.ch/downloads.html
http://hrd.ham-radio.ch/downloads.html
http://g4zlp.ham-radio.ch/
http://www.westmountainradio.com/
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Installation 

Introduction 

The Ham Radio Deluxe kit is a standard Windows kit ï it supports Windows 98, 

Windows 2000, XP and more recent releases. Please note: version 3.4 is the last 

release that will óintentionallyô run on Windows 98. 

The Logbook uses the Microsoft Jet 4.0 Database Engine, see Database on page 

73 for more information. 

Ham Radio Deluxe 

Ham Radio Deluxe can be installed in under a minute. Special knowledge is not 

needed ï the kit does everything for you! 

You will not need to reboot your computer, HRD does not update your system 

files or change your systemôs configuration in any way. 

 

When you start the installation the first screen shows the release and build you 

are installing. 

 



 

You must accept the licencing conditions. Ham Radio Deluxe is free for radio 

amateurs and shortwave listeners, commercial use requires a licence. 

If you are a commercial (non-amateur user) stop the installation now unless you 

have a licence. 

 

 

Select the folder where Ham Radio Deluxe will be installed, the suggested 

default is usually sufficient. 

 



 Installation  ¶  17 

 

Select the folder in the Start menu where the Ham Radio Deluxe entries will be 

added, the suggested default is usually sufficient. 

 

 

Click Install to start the installation. 

 



 

The progress of the installation is shown while the software is being installed. 

 

 

When the software has been installed select the programs to be started, then 

press Finish. 
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First Steps 

Connection 

Now that you have installed HRD you can try it out using a Dem-o-matic radio. 

This is a reasonably accurate simulation of the real thing, designed for use 

during presentations and while developing HRD when a radio is not available 

(on the train, in a plane, in an airport, stuck in a hotel room in Finland etc.). 

From the Start menu select Programs > Ham Radio Deluxe. Once the splash 

screen has closed you see the Connect window. 

 

 

Dem-o-matic 

The Dem-o-matic radios do not need cables ï simply select Dem-o-matic in the 

Company dropdown, select an option in the Radio dropdown, and then press 

Connect. 

They are ideal for demonstrating HRD when you do not have a suitable radio 

available. 

Options 

Company 

Select your radio manufacturer from the drop-down list.  



FlexRadio: you must install the vCOM virtual serial port drivers from Philip 

Covington (N8VB). These are used to provide the connection between HRD and 

the PowerSDR sofware that must be running before you try to create the 

connection with HRD. More information is available from http://www.flex-

radio.com/, to install the vCOM drivers see Annex: N8VB vCOM on page 163. 

ICOM: disable the CI-V Transceive option for best performance. 

Kenwood: make sure Packet communication mode is switched OFF (if 

supported). Most Kenwood radios require CTS and RTS to be ON for flow 

control. 

Radio 

Select your radio model from the drop-down list. 

COM Port  

The COM port on this computer where you have connected the radio interface 

cable. 

Make sure that you do not have other programs using the same port, for example 

mobile phones and personal organisers. 

Select 'Auto-detect' to try all available ports. 

Speed 

The speed used for communicating with the radio, check the speed setting via 

the radio's configuration menu. 

Select 'Auto-detect' to try all available speeds. 

CI-V Address 

ICOM only: the address assigned to the radio, consult the radio's handbook for 

the default address. This can also be configured via the radio's configuration 

menu. 

CTS 

Enables the CTS flow control, required for Kenwood radios. 

DTR 

Enables the DTR line when the COM Port is opened and leaves it on, usually to 

provide power for an interface cable. For Yaesu CT-62 and ICOM CT-17 

interfaces this can be left unchecked (off). 

RTS 

Enables the RTS line when the COM Port is opened and leaves it on, usually to 

provide power for an interface cable. For Yaesu CT-62 and ICOM CT-17 

interfaces this can be left unchecked (off). 

Connecting 

Press Start to connect to the radio. If you see the error below then the COM port 

is currently held open by another program. 

 

Check that you have not started another radio control program. Other culprits are 

PDA and mobile phone connections. Even if you have disconnected a device 

from a COM port you must make sure that the software is no longer running. 

http://www.flex-radio.com/
http://www.flex-radio.com/
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One connected HRD reads the radioôs frequency to ensure that the options you 

selected are correct. If you see the error below then HRD failed to read the 

radioôs frequency: 

 

If HRD can read the frequency the Connect window is replaced with the main 

radio display ï you are now using HRD! 

If HRD cannot read the frequency then check: 

¶ Correct COM port is selected, 

¶ Speed on radio is the same as the speed selected in HRD, 

¶ Your cable ï you may have a NULL modem cable when a normal 

serial cable is needed, 

¶ Cable is connected correctly to your PC (you may have more than 

one COM port), 

¶ DTR / RTS are selected if required to power an active cable such as 

CT-62 or a cable from third-party provider. 

If you still canôt get started refer to: 

¶ Annex: Command Tester on page 153, and 

¶ Annex: Portmon on page 161. 

Whatôs Next 

A taste of whatôs to come later in this guideé 

Appearance 

Set the appearance: 

¶ From the View menu select Colour Schemes, 

¶ Select Customise Layout and Program Options from the Tools 

menu. 
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Radio Display 

Introduction 

The HRD radio display has many, many features. This section attempts to 

describe everything you can do in this display. 

HRD is designed to be intuitive; nevertheless even the author has problems 

remembering all the available options! 

To aid in the clarity of the screenshots the LCD Scheme is used. 

 

 



Frequency Display 

 

Configuration 

See Frequency on page 34. 

Dropdowns 

If you have enabled dropdowns as part of the configuration just click on a 

dropdown and make a new selection. 

Mouse Wheel 

When you rotate the mouse wheel in the frequency display the currently active 

digit is incremented / decremented depending on the scroll direction. 

If you rotate while the cursor is over an inactive digit then the digit is activated. 

Up/Down 

The up-arrow, down-arrow, - and + keys increment / decrement the active digit. 

Mouse-click 

Select a digital by clicking over the digit. To increment / decrement click above / 

below the center of the digit and keep the mouse button pressed. 

Direct Entry  

To enter values just press a numeric key (0-9). The active digital is updated and 

the next digit to the right is made active. 

Press Enter to display the Enter Frequency window. 

 

Enter the new frequency, and then press Apply. 

If you check Auto-apply then the new frequency is applied every time you make 

a change. 

If you check Track this window is updated with changes made to the frequency 

display ï for example when you tune the radio manually. 

Griffin etc.  

Support for third-party devices such as the Griffin Powermate is available ï see 

Accelerators on page 39. 
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Tuning Dial 

Fine Tuning 

 

There are two fine tuning ranges ï Fine I and Fine II. In the Tuning menu select 

Show Fine II to show the second range. (If you are only showing Fine I then the 

title is Fine.) 

Set the range from the Tuning menu or by clicking the  button. 

To change the mouse wheel step click the  button (also set with the Mouse 

Wheel pane of Program Options on page 44). 

To change the frequency either: 

¶ Drag the marker with the mouse (and keep on dragging ï the bar 

will scroll to the left or right), 

¶ Rotate the mouse wheel (press Shift to increase the mouse wheel 

step by a factor of 2, press Ctrl to increase by a factor of 5),  

¶ Click in the tuning bar or on frequency text such as 14.235.0. 

Main Tuning 

 

The differences between a main tuning bar and a fine tuning bar are: 

¶ The range is fixed (defined by the Band Layouts on page 57), 

¶ The bar does not automatically scroll to the left or right. 

Band Selection 

The Band Section buttons are shown between the Fine and Main layouts. 

 

The buttons are: 

¶ ALT, 

¶ BSP, 

¶ Band buttons ï 160m, 80, é and 10m. 

ALT ï only displayed if you have two VFOôs displayed (for example Kenwood 

TS-2000), switches between the main and alternate (second) VFO. When 

highlighted you are tuning the second VFO with the tuning dial. 

BSP (bandspread) ï when you press BSP a new layout is dynamically created. 

The current band is split into multiple segments, for example the 20m band (14 

MHz ï 14.350 MHz) can be split into 7 segments, each of 50 kHz. 

To restore the previous layout press BSP and select Off. 

The band buttons select the corresponding band; the last used frequency and 

mode for the band are restored. 



Display Scroll 

 

If there is not enough room to display all the frequency ranges defined in the 

current band layout use this button to scroll the frequency ranges (bands) up or 

down. 

Band Selection 

 

The current band layout. Click here to select a different layout from the Bands 

menu. 

 

Date & Time 

 

Click here to set the clock format. 

 

Buttons 

 

What would a radio be without buttons? Press a button to active the option. If it 

is a button where the option state can be read from the radio ï for example the 

selected VFO ï the button indicates whether the option is currently selected. 

This should be obvious  . 
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Dropdowns 

 

When to press a dropdown button a popup menu is displayed. Select an option or 

press escape. If possible the dropdown displays the current selected option. 

Again, this should be obvious. 

Sliders 

 

Select the sliders that are displayed with the Sliders: Layout pane of Customise 

Layout ï see page 36. 

Use the mouse to adjust a slider value. 

In the View menu select whether sliders are displayed with the Slider Controls 

option.
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Customise Layout 

Introduction 

Used to define the appearance of the radio display, Customise Layout is selected 

from the Tools menu, or by pressing the Customise button. 

 

Schemes 

 

Schemes are pre-defined customizations created by author and by other HRD 

users. 

There are four default schemes shipped with HRD: Scheme #1 - #3 and the 

System Default. 

The HRD team and the HRD users have created the other schemes. Special 

thanks to Danielle in Northallerton, UK. 



Select a default scheme by pressing the scheme button (or select an entry and 

press Select); select one of the other schemes by double-clicking on the entry in 

the Schemes list. 

To save the current layout press Save ï you will be prompted for a Scheme 

name. 

Use Rename and Delete to organise the available schemes. 

Layout 

 

HRD is a data-driven program. For each radio there is a table of supported 

commands and associated button / dropdown / slider names. The layout order is 

more-or-less alphabetical. 

An early complaint was that the buttons positions were not user-definable; as a 

result the Layout window was designed. 

Donôt be put off by the amount of information in this window ï take it slowly 

and read the information here. 

The layout definition is saved on a per-radio basis in the registry. 

Dropdown Button / CAT Command / Macros 

You can create new buttons  - for example, to create a USB button from the 

Mode dropdown: 

¶ Select an empty button position ï the selected entry will start to 

blink (you can reposition this button later), 

¶ Press Select (above the Save and Load buttons), 

¶ In the Configure Button Mapping window select Mode : USB and 

enter the text to appear on the new button, then press OK. 
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¶ The previously empty button position now has a new value ï USB! 

Hiding  

Hide dropdowns hides the dropdown buttons to the right of the layout window, 

releasing two columns where you can assign new button definitions. 

Hide status texts hides the three top-left meters (-1-, -2-, -3-) and the status text 

area underneath, releasing two columns where you can assign new button 

definitions. 

Moving Entries 

Move the selected entry by simply dragging it with the mouse or by using the 

four arrow-buttons. 

    

Removing Entries 

To remove an entry either drag it into the Unassigned list or right-click on the 

button and select Clear from the popup menu. 

Dropdowns 

Select the dropdown menu, and then simply drag an entry to an unused location 

in the display. 

If you drag to a location that already has a definition the current definition is 

removed, if a standard button it is returned to the unassigned list.  

Unassigned 

Entries in the Unassigned list are standard buttons that are not currently 

displayed. Simply drag an entry to an unused location in the display. 

If you drag to a location that already has a definition the current definition is 

removed, if a standard button it is returned to the Unassigned list. 

Styles 

In the Buttons pane (page 32) you define up to seven button styles, shown here 

in the Button Styles group. 

To assign a style to a button either: 

¶ Drag the style over the button, or 

¶ Click a style to apply it to the currently selected (blinking) button. 

Save / Load 



To distribute your layouts with other users of your radio model use the Save and 

Load buttons. 

Buttons 

 

Define: 

¶ Seven button colour combinations, 

¶ The font, and 

¶ The button size. 

The default button size is small; this is so that users with low resolutions such as 

800 x 600 still have a usable configuration. 

There are no rules when using the button size; select the size which pleases you 

most. 

For the technical readers the button size is tied to the font size of the radio 

display form (font is Microsoft Sans Serif, size is 8, 9, 10 or 12 point). 

Changing the font size simply changes the font assigned to the form. 



 Customise Layout  ¶  33 

Faceplate 

 

Background 

These colours are applied to the background area of the display and to the 

transmit meters (if any) such as PWR, SWR and ALC. 

Status Window 

The status window displays information which you cannot normally change 

using buttons or sliders in HRD. 

Typical examples are Scanning status, Split mode and Memory channels. 

Clock Position 

The clock is displayed to the left, right or both sides of the band title. 



Frequency 

 

If your radio supports simultaneous access to two VFOôs (Kenwood, some 

Yaesu) then HRD will display two VFOôs, otherwise just one VFO is displayed. 

First select the VFO you are updating ï main or sub. 

The colours you can set are: 

¶ Background, 

¶ Frequency ï the digits, 

¶ Active Posn ï the bar above and below the current digit, 

¶ Inactive Posn ï the bar above and below the other digit, 

The Font can also be set, use the Main > Sub and Sub > Main buttons to copy 

settings between VFOôs. 

Dropdowns 

The dropdown buttons (Mode, Filteré) can be displayed at the top of the main 

frequency display. 

Select: 

¶ None (no dropdowns), 

¶  Mode (only the mode dropdown) or 

¶ All (all dropdowns). 

If Mode or All is selected you can check Add Border to add a border around the 

text. 

If All is selected you can check Include Title to add the Dropdown buttonós title 

(if there is room). 

 


